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Note a I’attention du lecteur

Dans la suite du document, il est implicitement considéré que la suite LibreOffice est
installée dans sa version 4 sur un poste de travail doté d’une version Windows.
Licence

creative | Cette documentation utilisateur est mise a votre disposition sous licence
commons . . .

Creative Commons par le groupe MimO. La licence CC by nc sa
s’appliqgue a 'ensemble du document a I'exception du logo MimO régi par
des dispositions spécifiques.

@ @@@ Le contrat est un contrat Paternité-NonCommercial-ShareAlike 2.0 France

disponible en ligne en cliquant sur le logo ci-contre.

Vous étes libres :

- de reproduire, distribuer et communiquer cette création au public,
- de modifier cette création.

Selon les conditions suivantes :

Paternité. VVous devez citer le nom de I'auteur original.

@ Pas d’Utilisation Commerciale. Vous n'avez pas le droit d'utiliser cette
création a des fins commerciales.

~

Partage des Conditions Initiales a [I'ldentique. Si vous modifiez,
@ transformez ou adaptez cette création, vous n’avez le droit de distribuer la
création qui en résulte que sous un contrat identique a celui-ci.

> A chaque réutilisation ou distribution, vous devez faire apparaitre clairement aux autres
les conditions contractuelles de mise a disposition de cette création,

» chacune de ces conditions peut étre levée si vous obtenez I'autorisation du titulaire des
droits.

Ce qui précéde n’affecte en rien vos droits en tant qu’utilisateur (exceptions au droit
d’auteur : copies réservées a l'usage privé du copiste, courtes citations, parodie...).

Ce qui précede est le résumé explicatif du contrat de licence. Le contrat complet est
disponible sur le site « Creative Commons France » :
http://creativecommons.org/licenses/by-nc-sa/2.0/fr/legalcode.

Pour obtenir plus d’information sur les licences Creative Commons :

consultez le site : http://creativecommons.fr

'adresse postale de Creative Commons : CERSA CNRS Université Paris I
10 rue Thénard 75005 Paris
Téléphone : 01 42 34 58 97

Dispositions spécifiques pour I'utilisation du logo MimO

Le logo MimO est la propriété exclusive du groupe Mutualisation interministérielle
pour une bureautique ouverte. Il est apposé sur les documents (notice technique,
documentation...) validés par ce groupe.

Il ne peut étre utilisé sur des documents créés ou modifiés par des tiers.

Toute copie, reproduction ou représentation intégrale ou partielle de ce logo, par quelque
procédé que ce soit, en dehors de l'intégralité du document original sur lequel il est
apposé, est illicite et constitue une contrefacon.
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CONVENTIONS DE NOTATION

Tout au long de ce manuel, vous pourrez rencontrer un certain nombre de signes

(pictogrammes). Ces derniers sont destinés a attirer votre attention sur des points
particuliers.

Chacun des pictogrammes a un but spécifique, comme [lindique la table de
correspondance ci-dessous :

Pictogramme Correspondance
L o
E ) Attention, important
~ Astuce

% Procédure

| Instruction

Fichier Edition Affichage Insertion Fo Nom de menu, Nom d’'une commande dans
Nouveau v le menu

Suppr Touche clavier de la Gallery

o
% |_| * Bouton EnrecisTRER de la barre
d’outils Standard
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1- INTRODUCTION

1.1 - La suite LibreOffice

LibreOffice (parfois abrégé en LibO) désigne a la fois le logiciel libre de bureautique, la
communauté de développeurs, le site internet hébergeant I'ensemble du projet.

La suite bureautique est divisée en plusieurs modules pouvant interagir entre eux et
partageant des concepts généraux communs :

» Writer : traitement de texte.
Les documents réalisés avec Writer ont I'extension « odt» ou «ott» pour les
modéles.

» Calc : tableur.
Les fichiers réalisés avec Calc ont I'extension « ods » ou « ots » pour les modeles.

» Draw : dessin.
Méme si DRAW n’est pas un logiciel de PAO (publication assistée par ordinateur), il
est possible de réaliser des documents élaborés. Les fichiers réalisés ont I'extension
« 0dg » ou « otg » pour les modéles.

» Impress : création de présentations.

Les fichiers réalisés avec Impress ont I'extension « odp » ou « otp » pour les
modeles.
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1.2 - Environnement DRAW

1.2.1- Lancement

Cliquer sur le bouton ‘s demarrer de la barre des taches.

PROGRAMMES, LibreOfficexx
Le détail de tous les modules LibreOffice est visible.
Cliquer sur l'option LibreOffice draw.

ou

sur I'icone du bureau.

1.2.2 - Ecran d’accueil

!’écran d’accueil s'affiche au démarrage de LibreOffice sous la forme d’un assistant.

Fichier Outils Aide

W Ouvrir un fichier
r:lE Modéles
Créer: )

a Document Writer

Classeur Calc

\

Présentation Impress

Dessin Draw

Formule Math Bienvenue dans LibreOffice.

Utilisez le volet latéral pour ouvrir ou créer un fichier.
E Base de données Base

1 Nouveauté de la version 4
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1.3 - Les fonctions disponibles

Le module Draw de LibreOffice permet de réaliser entre autres, les actions suivantes :
* dessins a main levee ;
* remplissage des formes : uni, dégradé, motifs ;
* possibilité de rendre un objet plus ou moins transparent ;
* épaisseurs, couleurs, styles, extrémités des lignes ;
* possibilité d’insérer des cotations (comme sur un plan) ;
* insertion de texte dont on peut préciser les caractéristiques a lintérieur de
formes ;
* texte 3D et effets sur les caractéres (titres) ;
* utilisation de cliparts (WMF, CGM...) ;
* création d'objets 3D. ;
* disposition, alignement, répartition des formes ;
* groupement, combinaison, fusion de formes pour en créer une nouvelle ;
* vectorisation d'images bitmap ;
* possibilité de créer plusieurs pages par document ;
» édition de pages web.
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2 - L'INTERFACE

La fenétre de travail se présente de la maniere suivante :

* dessins de formes géométriques élémentaires :

(Bézier), polygones, ellipses, cercles, secteurs,

Barre de titre
Nom du document actif

segments, lignes, courbes

Barre
es menus

E

Barre d'outils
AFFICHAGE, Standard

/ —
/ _—
P = ‘
. N —— =
|2] Sans nom 2 - LibreOffice Draw o ot
Fichier Egition Affichage Insertion Format Outils Modifier Fenétre Aide
B-EB-Ew v Ba YE ® S PSR- I
B = 000cm [+ (D [+] @ [coutewr [-|mEED [~] & @& -fd - -
Pages x|/ T 14 12 10 8 / 4 2 g 2 4 6 8 10 12 14 16 1820 22 24 26 28 30 32 34 *|| _
1 7 . ”::;?
. Volet latéral i
Barre d'outils *
) AFFICHAGE, Ligne et remplissage
-3 '|':A
_ 2
= Barre
= de défilement| =
Volet Pages =
AFFICHAGE, Volet Page | ..
7l \Mlse en page){Controlesf(Lignes de cotef U L] [ [
./%Qqu%%Q@@EDi& Ol ) - |
i 3495/383 ZZZZZUUUXUGU [z Diapol /1| Standard N = =4 + | 34%
; i
\
-1

Outils de dessin
AFFICHAGE,
Barre d'outils,Dessin
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Les ajouts par rapport a la fenétre de travail des autres modules de LibreOffice sont :

* Le volet page qui permet d’ajouter, de renommer ou de supprimer des diapos dans le
document.

* Les onglets d'accés aux couches qui permettent d’ajouter, de renommer ou de
supprimer les couches contenues dans les pages du document.

* La couche Mise en page est l'espace de travail par défaut. Elle détermine
I'emplacement du titre, du texte et des substituants d’objets de la page.

* La couche Contréles peut étre utilisée pour les boutons qui sont affectés a une
action, mais qui ne doivent pas étre imprimés. Définir les propriétés de la couche de
facon a ce que celle-ci ne soit pas imprimable. Les objets de la couche Contrdles sont
toujours placés devant les objets des autres couches.

* La couche Lignes de cote permet de tracer, par exemple, les lignes de cote. Pour
afficher et masquer ces lignes, il suffit d’activer ou de désactiver la couche.

A noter : Afficher une barre d’outils

Si la barre d'outils Dessin n’est pas visible, le menu Affichage — Barre
d'outils — Dessin permet de [afficher. Cette barre peut ensuite étre
ancrée en haut ou en bas afin d'étre toujours accessible ou laissée
flottante.

.

2.1.1 - Volet latéral

’Le volet «tache » devient le volet latéral, il est activé par défaut. Le volet latéral contient
les proprietés (mises en page types de contenu proposés (paragraphe,
caracteres,zone...), le styliste, la gallery, le navigateur

3Ce volet se loge par défaut a droite de la page.

B

Afficher les volets
AFFICHAGE, Volet latéral de la barre des menus.

2 Nouveauté de la version 4
3 Nouveauté de la version 4.3
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Titre du volet

Poignée de réduction du

bandeau

/_’>

Propriétés x
# Caracters e
Bempilir :

|Couleur {==| > I
Transparence :

P-un:un v EL

H Ligne E

& Position et taille =

f st h

|

|Menu de la barre des volets

affichés

~Propriétés

"Styles et formatage

Gallery

Navigateur

Cliquez pour plus d’options
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3 - LA BARRE D’OUTILS DESSIN

|E| S 2 E@T €-"% " =2-@ -@-¢-@-H-¥%- &£ & @|@|@-[u¢.vﬂj.

Chaque outil permet de dessiner un objet indépendant que I'on peut sélectionner pour le
modifier (épaisseur, couleur de trait, remplissage...) pour le déplacer, re-dimensionner,
pivoter... Les objets peuvent étre regroupés, superposés. A noter la présence d’objets
texte et Iégende. L'ensemble des outils proposés suffit pour réaliser des cartes et croquis,
toutefois les utilisateurs avertis pourront directement créer leurs cartes avec le module
Dessin, beaucoup plus puissant.

Les différentes icones de la barre d’outils dessin sont présentées ci-apres.

Outil icone Résultat Complément

Sélection s Pour sélectionner un objet : cliquer

I'objet.

Pour sélectionner nlusieurs objets,
- i

utiliser la touche L

ou encadrer les objets a la souris

O]
.l.
(11

Sélection en mode « éditer les points »
(aprés avoir cliqué sur « Editer des
points » dans la barre de fonction)

Sélection en mode « rotation » (aprés

avoir cliqué sur « Rotation » dans la
barre de fonction)

Ligne (trait) i B ------— | Outre diverses lignes classiques, la
— W barre de fonctions permet de créer des
Fléches
- .
En combinant avec la touche\i ,on

obtient des lignes formant des angles
précis (90° ou 45°)

Ligne main levée B i Dessiner en cliguant, glissant et

relachant le pointeur.
ﬁ Les lignes peuvent avoir des
représentations trés variées en utilisant

— la barre outil de fonction.

oY
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Polygone (ligne) L 64 Q

Outil ajouté a la

barre d’origine \ ? \ 7

Dessine une ligne composée d'une
série de segments de lignes droites.
Cliquer, glisser le pointeur puis cliquer
pour fermer le segment, continuer ainsi
pour chaque segment : la figure peut
étre ouverte ou fermée.

La touche \G_ permet de réaliser des
angles 45°/ 90°.
Attention : pour fermer un polygone,
revenir au point initial et double cliquer,
ainsi il peut étre « rempli »

Remarque : avec le module Dessin, il
arrive que le dessin de polygone soit
« bridé », c'est que la «grille est
activée » (Aller dans « Afficher grille »
et décocher « Aligner sur la grille » ce
qui aligne automatiguement les objets
sur les lignes verticales et horizontales
de la grille.)

Rectangle m

Tout objet surface (polygone fermé)
peut-étre rempli en couleur, hachures
ou dégrade...

Dessiner avec la Touche \Lpermet de
tracer des carrés

Ellipse ' - .

Tout objet surface (polygone ferme)
peut-&tre rempli en couleur, hachures
ou dégrade...

n )
Dessiner avec la Touche permet de
tracer cercles

Secteur d’ellipse -

Dessiner le cercle en glissant le
pointeur puis cliquer pour définir le point
de départ et re-cliquer ensuite pour
définir sa limite.

Possibilité de jouer sur I'épaisseur de
tous les traits

Ici rempli en dégradé

Segment de cercle O

Dessiner le cercle en glissant le
pointeur puis cliquer pour définir le point
de départ de I'arc et re-cliquer ensuite
pour définir sa limite.

Possibilité de jouer sur I'épaisseur de
tous les traits

Rempli en hachures
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Courbe

Toute forme de "courbe de Bézier
lisse " est réalisable. Attention a bien
manipuler cet outil par un simple
cliquer/relacher/glisser avec
uniquement un double clic a la fin.
C’est la distance de glisse du curseur
qui détermine la courbe que I'on peut
ensuite modifier avec les « tangentes »
(la ligne avec les petits cercles bleus)

Arc d’ellipse

U

Dessiner le cercle en glissant le
pointeur puis cliquer pour définir le point
de départ de l'arc et re-cliquer ensuite
pour définir sa limite.

Possibilité de jouer sur I'épaisseur de
tous les traits

Texte

Texte encadré |

Texte non encadré

|AJIRETN

Dessiner le cadre texte puis écrire
ou copier le texte.
-Possibilité d’encadrer ou non un
texte avec la barre de fonctions.
-Rotation possible avec [I'outil
rotation

Légende

Légende classique

Légende arrondie

Légende modifiée

La Iégende est un outil trés utile.
D’origine, c'est un rectangle.

On peut la transformer en I|égende
arrondie en glissant la plus grande des
poignées d'angle lorsque le pointeur
prend la forme d’'une main.

-pour modifier la taille, glisser une
poignée de la légende.
-pour ajouter du texte, cliquer sur le
bord de la légende puis saisir ou coller
du texte.

Formes de base

OoCoOdoQo
GANMNTOC T
GCC O O@aA
8 alld

Cliquer sur la fleche pour afficher les
différentes formes. Cliquer pour en
sélectionner une puis la dessiner a la
souris.

Avec la barre automatique de fonctions
de dessin, possibilité de modifier :

-la ligne de contour

-le remplissage

-la position (rotation)
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Formes symboles

© 5 D Z Qe
OB [ )

Cliquer sur la fleche pour afficher les
différentes formes. Cliquer pour en
sélectionner une puis la dessiner a la
souris.

Avec la barre automatique de fonctions
de dessin, possibilité de modifier :

-la ligne de contour
oo @ @ -le remplissage
-la position (rotation)
Fléches o - Cliquer sur la fleche pour afficher les
TCRSV TR A - différentes formes. Cliquer pour en
sélectionner une puis la dessiner a la
[}
t 1}0 ci}D L> Sriic8 souris.
= O D B Avec la barre automatique de fonctions
B de dessin, possibilité de modifier :
LoD e -la ligne de contour
PP -le remplissage
-la position (rotation)
Organigrammes i Cliquer sur la fléeche pour afficher les

O00<¢ o708
D0 Cavw

différentes formes. Cliquer pour en
sélectionner une puis la dessiner a la
souris.

O O (] t/;] ® P Avec la barre automatique de fonctions
de dessin, possibilité de modifier :
> <o AN O D |-aligne de contour
-le remplissage
O o .
Qo -la position (rotation)
Légendes g] - Cliquer sur la fleche pour afficher les
différentes formes. Cliquer pour en
[ Q O sélectionner une puis la dessiner a la
souris.
&3 ,0 ,0 Avec la barre automatique de fonctions
O de dessin, possibilité de modifier :
! -la ligne de contour
-le remplissage
-la position (rotation)

Etoiles Cliquer sur la fleche pour afficher les
différentes formes. Cliquer pour en
sélectionner une puis la dessiner a la

% - IR g SR K P

#41P RO

souris.

Avec la barre automatique de fonctions
de dessin, possibilité de modifier :

-la ligne de contour

-le remplissage

-la position (rotation)

MODULE DRAW - DOCUMENTATION UTILISATEUR

17 /64




Editer les points

LT

Pour éditer la forme d’un objet de
dessin sélectionné et faire apparaitre
les points de I'objet.

Fermer Bézier
Outil ajouté a la
barre d’origine

Aprés avoir édité les points d’un
polygone, permet de les fermer
afin de pouvoir remplir le polygone
d’une couleur.

FontWorkGallery

Fontwork Gallery

Sélectionner un style Fontwork :

Permet de créer des styles fantaisistes
dont [I'utilité reste a démontrer en

[a] cartographie.
i rr\ Fm
i K
A partir d’un fichier [ ™Y Permet d'insérer directement, a partir
d’un fichier, une image.
Extrusion Active ou désactive les effets 3D pour
oy les objets sélectionnés.
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4 -

LES FICHIERS DRAW

4.1 -

Créer

B

4.2 -

Fichier » Nouveau » Dessin de la barre des menus.
Une diapo au format A4 est créée par défaut.

Pour modifier le paramétrage de la diapo :

Format » Page de la barre des menus.

Insérer une page

B

4.3 -

Un fichier peut contenir plusieurs pages.

Pour insérer une nouvelle page Insertion » Diapo de la barre des menus,
ou

dans le volet page, clic droit nouvelle page.

De la méme maniére, on peut dupliquer une page en utilisant Insertion » Dupliquer
la page de la barre des menus,

ou
dans le volet page faire un copier, coller.

Champs « numéro de page » et « nombre de pages »

B

La fonction « nombre de pages » et « numéro de page » sont a effectuer en étant en
mode masque :

Afficher » Masque de la barre des menus,

puis

Insertion » Champs » Numéro de page et/ou Nombre de pages de la barre des
menus.

Mode Masque -
51 Cd  Fermer le mode Masque

<numeéro*> <nombre>

by

Les placer a l'endroit souhaité puis fermer le mode masque. Les numéros
s’incrémenteront en conséquence.

MODULE DRAW - DOCUMENTATION UTILISATEUR 19/64



4.4 - Gérer des commentaires

B

Draw supporte désormais les commentaires. Pour améliorer le mode collaboratif, il
est maintenant possible d’ajouter des commentaires a un dessin.

Insertion » Commentaire, de la barre des menus.

Le commentaire est ancré par défaut en haut a gauche de la page. Il peut étre
ensuite déplacé par un clic gauche de la souris positionnée sur le commentaire.

| Bi sans nom 1 - LibreOffice Draw

Fichier Edition Affichage Insertion Format Outils Modifier Fenétre Aide
B-EH® v BE % B B k@ @5 @ .,
PRd o - v | [0.00cm (& I Moir ~| & Coueuw v|0 v| =

Pages x| |[T7 -118117:16'15:14/13:12/ 1111008 8 F 1 B B rd 3 20T 10 203045 6 F 89100 1111201311411511611711811912

1 ﬂ eci est un exemple de commentaire

1594134244400 180 76 -5edr 3o 2-|1-- o0

Diapo1 I

Cette fonctionnalité était précédemment appelée « Notes » sous Writer et Calc. Elle
est désormais renommeée en « Commentaires » afin d’'unifier la terminologie dans
tous les modules et assurer une correspondance avec les autres suites du marché.

4.5 - Enregistrer

B

La commande a utiliser est :

Fichier » Enregistrer de la barre des menus.

4.6 - Exporter

Vous pouvez enregistrer votre fichier sous une nouvelle forme qui sera utilisable avec un
logiciel différent. Il est toujours conseillé de conserver 'original en format LibreOffice pour
pouvoir le modifier, car le fichier d’exportation perdra ses spécificités. Il faut utiliser le
menu Fichier/ Exporter.
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Fichier » Exporter de la barre des menus.

Cette fonction permet d’exporter des dessins vers d’autres formats de fichiers (html,
pdf, bmp, gif, jpg...).

Les choix de format sont différents selon les modules. Le tableau suivant vous présente
les possibilités suivant les modules et les formats les plus conseillés par module.

Texte Dessin Présentation
POF - Portable Document Fammat {odf B [ocument HTML (OpenOffice.ong ) (it Document HTML (OpenCifice.org Impress) (ftml. k
| Sl J PDF - Portable Document Format {pdf) FDF - Portable Document Format ( pdf)
PDF - Portable Document Format (pdf) Macromedia Flash (SWF) (swf) ) Macromedia Flash {SWF) (.swf)
KHTML {xchtml) ¥HTML (et KHTML (xhtml) )
EMP - Windows Bitmap {bmp) BMP - Windows B'rtmapl |_.I:u_n1|:u}
EMF - Enhanced Metafile (.emf) EMF - Enhanced Metafile [.emf)
EPS - Encapsulated PostScript {eps) EPS - Encapsulsted PostScript { eps)
GIF - Graphics Interchange Format (g} GIF - Graphics Interchange Format {.gif)

Pour obtenir un fichier image a . . rioo o | JPEG -Jaint Ph i (ipa:i
JPEG - Joirt Phat h s G ina ] oint Photographic Experts Group {jpg: jped
o ogrephic Bpets Group (1p8.1Pe8| 11rr 062 Metafite (met)

i o’ Aalicd MET - 05/2 Metafile {met) atile (.
partir d’'une carte réalisée en mode PBI - Fortable Bitmap brm) Ew _ 3223.?.!; ?Ega}p ( pbm)
texte, il suffit de la copier puis| FCT-Mac Pict {pct) i - -

P P PGM - Portable Graymap (pgm) PGM - Portable Graymap (pgm)

PNG - Portable Network Graphic | png)

coller dans Draw pour réaliser| PNG - Forable Network Graphic {png) . ;
, P | PPM-Portable Pixslmap (ppm) E;’;‘ 'SPD“EF?'; F‘D‘F'map {ppm}

I'exportation dans le format désiré. | RAS - Sun Raster Image (ras) - SUHI bEII f‘{ ;1395 l-ﬁﬁ_}' )

g‘-\ﬁ- SScaIabIe \fMectaD{rIGlaphic}s {svg) SVM- Sfaar‘-?'ief\- I"!Tet ;EIE 'fasl:\lr nl_lc}s (sva)
- StarView Metatile (svm v N

TIFF - Tagged Image File Format (i i) T |aaged image Fle [Fﬂma}f (& 1)
WMF - Windows Metafile [ wmf) }I(PM }(I F'f' r\j’“s. e LW
XPM - X FiMap {xpm) - % FixMap (xpm)

PWP - PlaceWare { pwp)

Conseillé en format standard:| Conseillé en format standard : |Conseillé en format standard :
pdf (s’ouvre avec Acrobat Reader) | jpeg (bitmap) html (s’ouvre dans tout navigateur
gif (bitmap) pdf (s’ouvre avec Acrobat Reader)
png (bitmap) swf (s’ouvre avec un lecteur
tif (bitmap) Flash)

svg (vectoriel)
swf (s’ouvre avec un lecteur
Flash)
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4.7 - Importer une page Draw dans Writer

4.7.1 - Exportation depuis Draw

B

Fichier » Exporter de la barre des menus.
Dans le menu déroulant : Format de fichier, sélectionner StarView Metafile (SVM).
Nommer le fichier,
puis cliquer sur Enregistrer.
L

—* JPenser & changer de dossier, car par défaut le fichier s’enregistre dans le
dossier Gallery.

La fenétre suivante s’affiche :

Cliquer sur OK.

Le document est & présent exporté sous forme d’un fichier SVM.

P B
—=_' Conserver bien le document source en ODG, car le fichier SVM n’est absolument
pas éditable.

4.7.2 - Importation dans Writer

La méthode varie suivant la maniére dont on souhaite importer le fichier SVM dans Writer.
Dans tous les cas, lancer Writer et ouvrir le document...
Importer le SVM sous forme d’une image a déplacer dans le document :

B

Insertion » Image » A partir d’un fichier..., de la barre des menus.
Sélectionner le nom de fichier.
Cliquer sur le bouton « OuvRIR ».

Importer le SVM en fond de page :

B

Format » Page de la barre des menus ;
Onglet : Arriére-plan ;

Type : Image ;

Cliquer sur le bouton « PARCOURIR » ;
Sélectionner le fichier ;

Cocher ou non la case lien ;

MODULE DRAW - DOCUMENTATION UTILISATEUR 22/64



Ajuster le positionnement (position, remplissage ou carrelage) ;
OK.

Il est également possible dimporter le fichier en arriere-plan d’'un cadre, d'un
paragraphe, d’'un style de paragraphe...
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5- EDITER UN PDF

Historiquement, seul Adobe Acrobat Professionnal permettait I'édition d’'un fichier PDF.
Mais aujourd’hui, LibreOffice permet aussi de modifier le contenu d’un fichier PDF.

5.1 - Ouvrir un PDF avec Draw

B

Fichier » Ouvrir de la barre des menus.
Sélectionner et ouvrir le fichier PDF.

Le fichier est ouvert dans Draw. Ce n’est pas la panacée, mais d'une maniére
générale, I'essentiel du PDF est récupéré.

Le fichier PDF peut & présent étre modifié et, pourquoi pas, ré exporté ensuite en
PDF.

Penser tout de méme a conserver le fichier Draw en ODG en cas de besoin
d’édition ultérieure.
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6 - DECOUVRIR DRAW EN CREANT UNE MAISON EN PAS-A-
PAS

6.1 - Utiliser une grille pour mieux se repérer

Par défaut, les objets peuvent étre placés n'importe ou sur la page.
Il est cependant parfois utile de s’aider d’'une grille dont I'espacement lignes/colonnes est
modifiable.

B

Pour activer la grille, Affichage » Grille » choix des options dans le menu
déroulant.

Si vous souhaitez plus d’options, Affichage » Barre d’outils » Options.

La barre suivante apparait :

Options v X
& (] & ([8)8PaP o | 5[] O (s
1 2 3 4 5 6 7 8 9 10 11 12
1 . Mode rotation apres clic sur I'objet 7. Edition rapide
2. Afficher la grille 8. Sélection de la zone texte seule
3. Afficher les repéres 9. Double-clic pour éditer du texte
4. Reperes lors du déplacement 10. Poignées simples

5. Aligner exactement sur la grille, aux repéres |11. Grandes poignées
6. Capturer aux marges, a la bordure de I'objet, 12. Modifier I'objet avec des attributs

aux points de l'objet
6.2 - Tracer un carré ou un rectangle : la facade

B

Pour tracer la forme ci-dessous :

* cliquer sur le bouton « RecTANGLE" =1 de la barre d’outils Dessin ;

* placer le pointeur de la souris (une croix) a un des sommets du rectangle ;
* cliquer et garder le bouton gauche de la souris enfoncé ;

» déplacer le pointeur en diagonale.

Il est ensuite possible d’ajuster en tirant sur les points d’appui. En gardant la touche
majuscule enfoncée et en tirant sur les points d’angles, on conserve les proportions.

MODULE DRAW - DOCUMENTATION UTILISATEUR 25/64



6.3 - Tracer un polygone (45°) : le toit.

Dans ce type de tracé, les angles sont automatiquement construits sur des multiples de
45°. Ce tracé est facilité par la grille de points. Ce type de forme permet de dessiner le toit
comme ci-dessous :

B

Dans le groupe d’icones « Course » de la barre de dessin,

e E £
Fal T4
choisir I'icbne « Polygone (45°), rempli" B puis :
* placer le pointeur de la souris (une croix) pour débuter le polygone ;

cliquer et garder le bouton gauche de la souris enfoncé, ;

déplacer le pointeur jusqu’au sommet suivant ;

relacher le bouton de la souris ;

déplacer le pointeur jusqu’au sommet suivant et cliquer ;

recommencer de sommet en sommet ;

double-cliquer pour fermer le polygone.
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6.4 - Paramétrer une forme

Il est possible de modifier les styles de ligne, d’extrémité de ligne, de remplissage d’'une
forme. Aprés avoir sélectionné cette forme, les menus contextuels ligne et remplissage
proposent de modifier les parametres. Certains paramétres sont accessibles directement
dans la barre d’outils Ligne et remplissage.

6.4.1 - Modifier le style de ligne

Cliquer sur le bouton « LigNE" 8 de la barre d'outils Ligne et remplissage pour avoir
acces aux styles de ligne. La boite de dialogue suivante s’affiche :

Certaines options sont accessibles directement par les boutons de la barre d’outils Ligne
et remplissage :

() =~ |——| |o00m §| EENor v
1 2 3 4
1. Style de fleche 3. Largeur de ligne

~

2. Style de ligne . Couleur de ligne
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6.4.2 - Modifier le style de remplissage

Cliquer sur le bouton « RewmpLIssAGE" 4 de la barre d'outils Ligne et remplissage pour avoir
acces aux styles de remplissage. La boite de dialogue suivante s’affiche :

Le type de remplissage peut étre affiné dans les onglets Transparence, Couleurs,
Dégradés, Hachures et Motifs Bitmap.

Certaines options sont accessibles directement par les boutons de la barre d’outils Ligne
et remplissage :

'f? Couleur % |[C]Bleug w |
1 2
1 . Style de remplissage 2. Ombre. Donne une profondeur a un

objet. Son aspect peut étre modifié en
cliguant bouton RemPLISSAGE B et en
choisissant I'onglet « ombre »
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B

Dans le cas de notre maison il sera par exemple possible, aprés avoir dessiné porte
et fenétres par des rectangles « simples » :

* pour le toit, de donner une couleur d’arriere-plan puis de choisir hachure et de
modifier les hachures dans I'onglet Hachures,

* pour la porte, de la remplir par un dégradé et de modifier le dégradé dans l'onglet
Dégradé en choisissant le type de dégradeé, I'angle de mise en ceuvre, la premiere
et la seconde couleur,

* pour les fenétres d’en créer une orange puis de la dupliquer et de modifier la
copie en demandant une transparence a 50 %.

Le résultat pourra ressembler a 'image suivante :

6.5- Courbes a main levée : un nuage derriére la maison.

B

Dans le groupe d’icdnes « Course » de la barre de dessin,

O ¥ L2
O 1

Choisir I'outil « Ligne a main levée » b . Cette courbe se place devant la maison
(voir ci-apres pour la placer derriére la maison).

Double-cliquer pour fermer la courbe.

Remplir le nuage par ¥1 »=motifs Bitmap =ciel.

Modifier la forme en tirant sur les points d’appui.
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6.6 - Disposer les objets

6.6.1 - Ordonner les plans d’apparition
Chaque objet correspond a un plan. Les plans sont disposés dans 'ordre dans lequel les
objets ont été créés. Cet ordre peut étre modifié a chaque instant.

Sélectionner I'objet a déplacer.

B

Dans le groupe d’icdnes « Disposition » de la barre de dessin,

F=X=R-
9 ®

o -
Choisir l'outil « Envoyer vers l'arriere » . Le nuage se mettra derriere la

maison.
ou
Clic droit sur I'objet pour ouvrir le menu contextuel puis choisir :

Organiser = Envoyer a l'arriere.

6.6.2 - Aligner des objets.

B

Déplacer les fenétres vers le toit en les gardant alignées a égale distance.
» Déplacer une des deux fenétres vers le toit,

* puis pour aligner la seconde par le c6té haut, sélectionner les deux objets en
gardant la touche majuscule enfoncée,

* pointer sur un des deux objets et cliquer sur le bouton droit pour ouvrir le menu
contextuel puis choisir Alignement » En haut.
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* Les objets s’alignent sur I'objet le plus haut.

. A , . v A , N =
On obtient le méme résultat en cliquant sur l'icbne déployable « ALGNEMENT [ de la
barre d’outils Dessin et en choisissant I'outil « En haut ».

2 Pour zoomer rapidement sur un objet parmi plusieurs objets du document, cliquer

| -

sur I'icdne déployable « Zoowm" de la barre des menus, puis choisir I'outil « zoom sur

les objets ».
6.7 - Insérer du texte
6.7.1 - Insérer un objet texte
Il suffit d'utiliser le bouton « Texte” *  de la barre d'outils Dessin.

6.7.2 - Ecrire dans une forme

Il est possible d’écrire du texte a I'intérieur d’une forme pleine.

B

Sélectionner la forme. Double clic dans la forme, le curseur texte clignote. Entrer le
texte.

La barre d'outils Formatage du texte s’affiche. Toutes les modifications nécessaires
(police, taille, couleur...) sont alors disponibles.

6.7.3 - Insérer une légende

Cet outil permet de renseigner une étiguette de texte pointant éventuellement vers un
autre objet.

B

. o ) - o . L
Cliquez sur I'icone déployable « LEcenpes de la barre d’outils Dessin, puis faire
glisser le curseur dans le document a I'endroit ou vous voulez dessiner la forme.

Certaines formes possedent une poignée spéciale qu'il est possible de faire glisser
pour modifier leurs propriétés. Le pointeur de la souris prend la forme d’une main
lorsqu’il passe sur ces poignées spéciales.
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6.8 - Modifier les formes

6.8.1 - Sélectionner, Grouper, Dissocier

B

Apres avoir cliqué sur le bouton « SELECTIONNER" | de la barre d’outils Dessin, on
pourra sélectionner un objet en cliquant dessus.

Pour sélectionner plusieurs objets deux possibilités :

+ Garder la touche majuscule du clavier enfoncée et cliquer successivement sur les
objets a sélectionner. Un double clic sur un des objets annule la sélection de tous
les objets,

* OU, en gardant le bouton gauche de la souris enfoncé, faire glisser le pointeur
pour définir une zone rectangulaire dans laquelle tous les objets seront
sélectionnés.

Pour les grouper, les dissocier :

* Apres les avoir sélectionnés, clic droit Grouper

ou

Modifier » Grouper de la barre des menus.

* Une fois grouper, pour les dissocier clic droit Dissocier
ou

Modifier » Dissocier de la barre des menus.

Le groupement d'objets permet ensuite de déplacer ou de redimensionner plus
rapidement 'ensemble des objets appartenant au groupe.

6.8.2 - Editer les points d’appui

s

Aprés avoir sélectionné un objet, cliquer sur le bouton « PoinTs" =2 de la barre
d’outils Dessin.

On peut ensuite modifier un des points d’appui et déformer la forme.
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6.8.3 - Arrondir un angle.

Quand on a demandé I'édition des points d’appui d’'un rectangle, un nouveau point
d’appui, plus grand que les autres, apparait.

Il permettra de créer des angles arrondis.

B

Pour le saisir, approcher le pointeur de ce point. La fleche du pointeur se transforme
en main. Enfoncer le bouton gauche de la souris, déplacer le pointeur pour obtenir
un arrondi.

6.9 - Utiliser les courbes de Bézier

6.9.1 - Transformer une forme ou un polygone en courbe.

s ..'\..-'\.
=~ On ne peut modifier certaines caractéristiques des points d’appui d’'un objet que si
celui-ci est une courbe.

Il sera donc peut-étre nécessaire de transformer un polygone en courbe pour pouvoir
éditer ses points d’appui.

On pourra alors déformer le polygone, créer des lignes courbes, ajouter ou retirer des
points d’appui.

/B

Pour cela, il faut sélectionner le polygone qui apparait alors avec ces points de
dimensionnement puis utiliser le menu contextuel » Convertir » En courbe.
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Refléter r | |

wy= En courbe
3 sl Enpolygone
il En contour
Mom, .. =
- & EnD

Editer le style dobjet... q;ﬂ) En corps de révolution 3D
% Couper En bitmap
Ex  Copier En métafichier
Ifi Coller

Les objets Texte peuvent également étre transformés en courbe.

6.9.2 - Courbe de Bézier

Cliquer sur le bouton « Points" 2 de la barre d’outils Dessin. Quand un objet est une
courbe, on peut éditer les points d’appui qui ont tous les caractéristiques d’une courbe de
Bézier.

Aprés avoir cliqgué sur I'objet & modifier, la barre d’outils Editer les points s’affiche et
propose plusieurs fonctions.

Pour utiliser une de ces fonctions, il faut cliquer au préalable sur le point d’appui sur lequel
on veut agir. Les lignes d’appui et les barres de controle apparaissent alors.

Lorsque I'on clique sur licéne Editer les points de la barre de fonction, la barre d’outils
s'affiche. Elle permet de travailler avec les polygones et de dessiner des courbes de
Bézier. Une courbe de Bézier est une courbe réalisée a partir d’'un point principal (appelé
point de jonction ou point d’inflexion selon le contexte) a partir duguel des « tangentes »
déterminent la forme de la courbe qui est dessinée. C’est en manipulant les tangentes que
I'on donne différents aspects aux courbes.

La barre d'objets Bezier s’affiche lorsque vous sélectionnez une courbe de Bézier ou un
polygone et cliqguez sur Editer des points.

Editer les points * X
=8| | %8 &%l D]
1 2 3 45 6 7 89 10 11
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1 . Editer des points 7. Point d’'inflexion : Convertis le ou les points
sélectionnés en points d’inflexion. Les points
d’inflexion possedent deux points de contrdle
déplacgables et totalement indépendants.

2. Déplacer des points: faire glisser le8. Jonction lisse : les deux points de contréle

point vers un autre emplacement ensont opposés par rapport au point d’appui et

maintenant le bouton de la souris enfoncé. ne peuvent étre déplacés qu’ensemble. Les
lignes de contréle peuvent étre de longueurs
différentes, ce qui entraine une courbure plus
ou moins importante

3. Insérer des points : cliquer sur la courbe/9.Jonction symétrique : Les deux points de

entre deux points et déplacer la souris encontrble sont opposés par rapport au point

maintenant le bouton enfoncé pour insérernd’appui et les lignes de contrdle sont de tailles

un nouveau point. égales. Le degré de courbure est le méme
dans les deux directions.

4. Supprimer des points : sélectionner un10.Fermer Bézier : ferme une ligne ou une
point (ou plusieurs points en maintenant la.courbe. Un second clic fait I'opération inverse.
touche Maj enfoncée). Puis, cliquer sur

cette icone.

5. Scinder une courbe : sélectionner parll. Réduire les points

exemple deux points sur un polygone, puis

cliquer sur cette icbne pour obtenir deux

objets.

6. Convertir en courbe : Convertis une

ligne droite en courbe ou vice versa. Si

vous sélectionnez deux points, le segment

situé entre les deux points est converti.

6.10 - L'extrusion (conversion 3D)

Transformer une figure en un solide en utilisant I'extrusion (échelle de profondeur), cela
permet de pouvoir extruder une surface suivant une direction précise dans le but d'obtenir
un solide (2D a 3D)

6.10.1 - Convertir un objet en 3D g e
Remplissage..
Texte.. 711811p120121122123124 125126
Pour créer un objet 3D sélectionnez l'objet puis # Petrewie |
cliquez avec le bouton droit de la souris A Caractére.
dans le menu contextuel choisissez l'option &1 Paragraphe..
Convertir —> En 3D il'_gaﬂi*'t '
1gnemen »
. . . . Refléter 3
ou dans la barre d'outils Dessin cliquez sur l'icéne Conyertir »| ot Encourbe
Description... &1 Enpolygone
= S En contour
= |(Dé5]activer|'ertru5innf rfj__ : & EniDt
Editer le style d'objet...
m qﬂb En corps de révolution 30
o6 Couper En bitmap
5 Copier En métafichier
B Coller |
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6.10.2 - Modifier un objet en 3D

Cliquez sur l'objet 3D avec le bouton de la souris et choisissez l'effet 3D. La boite de
dialogue correspondante donne acces aux parametres regroupés par theme dans les
onglets

Utiliser les niveaux de luminosité des pixels pour définir une hauteur

— Arrondi d'aréte : mettre a o pour des bords \
. / \
anguleux et augmentez le % pour arrondir /
les bords \ ‘
/

,///

— Echelle de profondeur : laissez & 100 % T~
pour une extrusion droite et plus de 100 %
pour une extrusion négative

— Profondeur : correspond a la hauteur d'extrusion
Le bouton perspective est a désactiver pour des objets longs

Le module 3D permet d'inclure quelques éléments prédéfinis (cube, sphére, cbne,
pyramide, etc.) ou définis par l'utilisateur depuis des formes 2D. Les formes 2D sont
transformées par extrusion droite ou conique et par révolution en trois dimensions.

Elles sont gérées par un outil unique Effets 3D qui donne accés a de nombreux réglages,
comme :

- Géométrie — échelle de profondeur , arrondi d'aréte

- Ombrage - mode de rendu (Gouraud, Phong, Plat), ombre portée, réglages de
cameéra

. Eclairage - huit sources de lumiéres | Effets 3D (=]
de type Spot (en plus de I'ambiance) i
avec un réglage individuel de la | 2 | ot ” Y ” = “ & I @M
couleur et de la position spatiale W

. Textures - gestion en cing réglages par bouton on/off des textures appliquées

- Matériau - réglages couleur/réflexion pour imiter les matiéres

Effets 3D S

Géométrie

Arrondi d'aréte 10 %

M Y

Echelle de profondeur 100 %

alv())4f+

Profondeur 121 cm
Segments
Horizontal 24 = Vertical M 2

Mormales

E
|
|

+

+[|nta

‘3
2 (8]
0
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On peut créer des formes 3D et les réunir dans un espace commun (Groupement 3D).
Vous pouvez combiner plusieurs objets graphiques en un groupe de facon a pouvoir les
utiliser comme un seul objet.

6.10.3 - Grouper des objets

1) Sélectionnez ensemble les objets a grouper. Maintenez la touche Maj enfoncée
pendant que vous cliquez sur chaque objet individuellement.
2) Faites un clic avec le bouton droit sur n'importe lequel des objets sélectionnés pour
ouvrir le menu contextuel.
3) Choisissez Grouper.
Aprés avoir groupé les objets, sélectionner n'importe quelle partie du groupe sélectionnera
le groupe entier.

6.10.4 - Entrer dans un groupe

1) Faites un clic avec le bouton droit sur n'importe lequel des objets dur groupe.
2) Choisissez Entrer dans le groupe.
3) Maintenant, vous pouvez sélectionner et éditer un simple objet du groupe.
Vous pouvez ajouter ou supprimer des objets du groupe dans ce mode.
Les objets ne faisant pas partie du groupe sont affichés en grisé.

6.10.5 - Sortir d'un groupe

1) Faites un clic avec le bouton droit sur n'importe lequel des objets du groupe.
1. Choisissez Quitter le groupe.
Vous pouvez également double-cliquer n'importe ou en dehors du groupe.

6.10.6 - Dissocier un groupe

1) Faites un clic avec le bouton droit sur n'importe lequel des objets du groupe.
Choisissez Dégrouper.
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7- LA GALLERY

7.1 - Lesimages de la Gallery

La fenétre Gallery stocke un ensemble d'images qui peuvent étre insérées dans n’'importe
quel document.

7.1.1 - Insérer un objet de la Gallery

B

Cliquer sur le bouton « GALLERY" de la barre d’outils Dessin.

ou

Si elle est ancrée,

cliquer sur le bouton bascule « MasQUER/AFFICHER » ———iic

* La partie gauche de la fenétre affiche des dossiers appelés themes.

* La partie droite affiche les objets contenus dans le théme choisi.

Cliquer sur le théme contenant I'objet a insérer.

Cliquer sur I'objet que I'on souhaite insérer, le faire glisser dans la diapositive.

Eventuellement, modifier les dimensions de I'objet.

7.1.2 - Ajouter une image dans la Gallery

B

Afficher la fenétre « Gallery ».
Choisir un théme, puis clic droit sur « Propriétés... »

Cliquer sur I'onglet Fichiers.
Choisir le type de fichier, puis cliquer sur le bouton « RECHERCHE DE FICHIERS... ».
Atteindre le dossier choisi, sélectionner le (s) fichier (s) a insérer.

Cliquer sur le bouton « Asouter » ou sur le bouton « Tout AJouTer » Si cela concerne
tout le dossier.

(Dés) activer I'Apercu.
ou

Cliquer sur un objet du document actif, maintenir le bouton de la souris enfoncé et
faire glisser I'objet vers la fenétre « Gallery ».
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7.1.3 - Supprimer une image de la Gallery

B

Afficher la fenétre « Gallery ».

Sélectionner un theme.

Clic droit Supprimer sur I'image de la partie droite du theme.
ou

Sélectionner I'image.

Appuyer sur la touche Super et confirmer la suppression de 'objet.

7.1.4 - Supprimer un théme de la Gallery

B

Afficher la fenétre « Gallery ».

Dans la liste des themes, choisir le theme a supprimer.
Clic droit Supprimer sur le theme sélectionné.

ou

Sélectionner le theme.

Appuyer sur la touche Sueer et confirmer la suppression du theme.
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8 - CONVERSION

8.1- En Bitmap

L'image bitmap se compose d’'un ensemble de points appelés pixels, dont les valeurs de
chacun décrivent la couleur et I'intensite.

L'apparence d’'une image bitmap dépend de sa définition et de la résolution d’affichage de
I'écran. Elle supporte mal les opérations de redimensionnement qui se traduisent par une
perte d’information.

Plus I'image comporte de couleurs et de pixels, plus son poids augmente, chaque point
étant codé et numérisé.

B

Sélectionner I'objet ou le groupe d’objets, Modifier » Convertir » En bitmap.
OU clic droit Convertir » En bitmap.

L'intérét de convertir en Bitmap est de pouvoir régler le contraste, la luminosité, les
gamma, la transparence et d’appliquer des filtres particuliers en utilisant la barre
d’objets graphiques qui apparait.

Inconvénient : perte de qualité a 'agrandissement.

Image vectorielle Image Bitmap

8.2 - En vectoriel

Une image vectorielle est la représentation d’entités géométriques telle qu’un cercle, un
rectangle ou un segment ayant des attributs de forme, de couleur et de corps de trait, de
couleur d'aplat, etc.

Les fichiers d’'images vectorielles sont souvent peu volumineux.

Autre avantage, I'image vectorielle n'impose pas de définition fixe de I'image. Un dessin
vectoriel peut donc étre agrandi et réduit a volonté sans perte de qualité, dans les limites
de définition de la carte de traitement d'image utilisée.

B

Sélectionner I'objet ou le groupe d’objets Modifier » Convertir » En polygone.
ou

Clic droit sur I'objet Convertir » En polygone.

La boite de dialogue suivante s’affiche :

Modifier les paramétres,
puis OK.
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8.2.1 - Appliquer des filtres Bitmap

Cette barre d'outils apparait lorsqu’un objet bitmap est sélectionné. Comme toutes les
barres outils, I'on peut utiliser le menu Afficher pour la faire apparaitre, puis personnaliser
les divers boutons.

Image A

M~ " |Standard v| M Plow 2| az 5

Les icbnes de cette barre d’outils sont présentées dans le tableau suivant.

Icone Action
N Insere une image a partir d'un fichier existant
ST la fenétre Filtres permet d’appliquer divers filtres a I'image
- sélectionnee.
B0 A -invertir / adoucir / augmenter netteté / supprimer interférences
& A =4 am -solarisation / vieillissement / poster / pop’art
& B X -dessin au fusain / relief / mosaique

Permet de modifier I'aspect d’affichage de I'objet bitmap L'objet

: : graphique incorporé ou lié dans le fichier actif n’est pas modifi€, seul
Noir /Blanc son affichage I'est.

Filigrane Le niveau de gris est utile pour transformer un dessin (une carte) en
vue d’un tirage en noir et blanc.

Icone Action

Couleur ™ X Spécifie la quantité du composant RVB (ROUGE-VERT-BLEU) dans
Aow 2 I'objet bitmap sélectionné.

Ao ($ . .

Les valeurs possibles vont de -100 % (pas de couleur) a +100 %

Ao ($ (entierement coloré).

e (0% |4

Cow = Reégle la Luminosite, le Contraste, le Gamma

YiLoo 2

Plow 2 Transparence de I'objet bitmap du minimum au maximum
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Icone Action
Aan 5 Refléte horizontalement ou verticalement I'objet bitmap
Icone Action

Propriétés de I'image (que I'on obtient aussi par un clic droit sur une
image bitmap) :

Image

Macro
‘T‘{DE |O|:-tion5 Adaptation du texte Hyperlien || Image | Rogner || Bordure | Arriére-plan

dont deux onglets sont particulierement intéressants :

Image |

Macro
Type || Options | Adaptation du texte Hyperlien || Image |R09ner |Bordure Arrigre-plan

Rogner
@K
) Conserver |a taille de lmage

A gauche | 0,00cm £ En haut 0,00cm £ Lt e |

A

A droite 0,00cm Enbas 0,00cm £

II

Echelle
Largeur 79%

4

4

Hauteur 79%

Taille de limage
13,89cm x 2,04cm

Taille d'origine

Largeur 10,98cm |5

Hauteur 1,61cm £

4
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\% :

Aprés avoir sélectionné un objet bitmap, lorsque I'on clique sur l'icbne un
choix d’icénes apparait permettant d’appliquer différents filtres :

-

* Invertir : inverse les valeurs des couleurs d’'une image en
T AN GE couleurs et les valeurs de luminosité d'une image en

s - niveaux de gris.
L° =A =~ gn

/o * Adoucir : adoucit le contraste d’'une image.

* Augmenter la netteté : augmente le contraste d’une image.
* Supprimer les interférences : supprime des pixels individuels d’'une image.

+ Solarisation : simule l'effet d’'une lumiére excessive lors du développement d’'une
photo. Une boite de dialogue permet de spécifier le degré et le type de
solarisation, le degré de luminosité, en pourcentage, au-dela duquel les pixels
doivent étre solarisés et d’'indiquer si les pixels a solariser doivent également étre
inversés.

* Vieillissement : I'image s’assombrit légerement et les couleurs peuvent devenir
plus grises ou plus brunes. Une boite de dialogue permet de définir I'intensité du
vieillissement, en pourcentage. Plus la valeur est élevée, plus I'image est vieillie.

+ Poster : cet effet repose sur la réduction du nombre de couleurs. Ainsi, les photos
ressemblent a des peintures. Une boite de dialogue indique le nombre de
couleurs auquel I'image sera réduite.

* Pop'art : par une transformation de ses couleurs, I'image change completement
de caractere, la fonction peut étre appliquée a toute I'image ou a une partie de
celle-ci.

* Dessin au fusain : les contours de l'image sont tracés en noir et les couleurs
d’origine sont supprimées. Cette fonction peut étre appliquée a toute I'image ou a
une partie de celle-ci.

* Relief: crée des effets de relief. Une boite de dialogue permet de choisir la
position de la source de lumiére imaginaire qui détermine le type d’ombre créée et
I'apparence de I'image en relief.

* Mosaique : rassemble de petits groupes de pixels en zones rectangulaires de la
méme couleur. Plus les rectangles sont grands, moins les images comporteront
de détails. Une boite de dialogue permet de déterminer le nombre de pixels a
regrouper en rectangles, la largeur et la hauteur de chaque élément de carrelage
ainsi que I'accentuation ou non des bords de I'objet.
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8.2.1 - Rogner un objet Bitmap

/ b
[} L 1

—— Seuls les objets Bitmap peuvent étre rognés.

B

Clic droit sur I'objet bitmap, cliquer sur l'icbne « Rogner I'image » &,
ou

Format » Rogner I'image de la barre des menus

La boite de dialogue suivante s’affiche :

Modifier les parametres,
puis OK

Image rognée (exemple le bas de la mappemonde est rogné)

() Conserver la taille de I''mage Annuler

Gauche (0,00 cm = Haut 0,00 cm

Echelle
Largeur 100 %

Aide

Rogner &
Rogner | OKl
@ Conserver I'échelle I}\;‘

Hauteur [100 % =

Taille de I'image
Largeur |16,88 cm 16,88 cm= 22,49 cm (96 PPI)

Hauteur |16,89 cm 5 Taille d'origine

8.2.2 - “Editer avec un outil externe

Nouveau menu pour les images avec des fonctionnalités associées. Possibilité d’ouvrir le
fichier avec d’autres programmes.

/B

Clic droit sur I'image
Sélectionner Editer avec un outil externe

4 Nouveautés de la version 4
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9 - REALISATION D’UNE CARTE

9.1 - Conception d’une carte

Toute carte réalisée dans LibreOffice n’est qu'une superposition « d’objets », parfois il faut
se montrer astucieux dans la conception, mais c’est avant tout la réflexion et la méthode
qui assurent I'efficacité et la qualité du travail de cartographie. Le tableau ci-apres montre
comment se compose/décompose une simple carte.

Objet rectangle en gris

2 Objets rectangles en bleu

mm
N 4 lignes a main levee en
v\)/ bleu
S
[
2 cercles en rouge (faire un
copier/coller)
[ J

Le fond coloré en jaune

Paris

1 objet texte

La carte ci-dessous est la résultante
de la superposition des divers objets
présentés dans ce tableau
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9.2 - Insertion d’une carte

9.2.1 - Ouverture de la Gallery
La Gallery est accessible par I'icone ou par l'item de menu Outils » Gallery.

C’est une fenétre ancrable.

9.2.2 - Insertion par Glisser déposer

Il faut cliquer et glisser la carte vers la zone de travail, la carte est alors insérée dans le
document sous forme d’objet de dessin.

De cette maniere, les objets constituant la carte sont dissociables les uns des autres et
donc modifiables un par un.

B

Il faut utiliser la commande contextuelle Clic-droit » Groupe » Dissocier ou le
menu Format » Groupe » Dissocier.

9.2.3 - Insertion par Clic droit

Aprés avoir sélectionné la carte a insérer, le clic droit propose le menu suivant.

—== ﬁr—'

Apercu .

Définit le mode
Titre objet graphique
un document.

Supprimer T
AR IS L s .

Il faut choisir I'item Ajouter » Copier
Avec cette méthode la carte est insérée sous forme d’'image et ne pourra étre exploitée
que si I'on veut « surcharger » la carte.

9.3 - Colorier les objets de la carte

Aprés avoir sélectionné un obijet, la barre de fonction permet de choisir une couleur de
remplissage.

Si le remplissage semble ne pas fonctionner, il faut vérifier que le polygone est bien un
polygone fermé et le fermer éventuellement. Il faut utiliser I'icéne Editer les points 7T

(disponible dans la barre d’outils dessin) qui fait apparaitre une nouvelle barre d’outils.
Editer les points v X

=||[<3| & A

L'avant-derniére icone (Fermer Bézier) est active si le polygone est un polygone ouvert, en
cliguant dessus il est fermé et la couleur de remplissage apparait.
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Modifier les couleurs
Lorsque I'on travaille avec un objet ayant une couleur, il suffit de le sélectionner d’un clic

droit pour ouvrir le menu contextuel « Remplissage » ou cliquer sur @* [ dans la barre
de fonctions
ﬁ Ligne...
Texte...

+ii§|+ Position et taille...

qui ouvre une fenétre Remplissage

X

Remplissage

| Remplissage ||Ombre || Transparence |Cuuleurs |Dégradés || Hachure || Bitmaps |

Propriétés

Mom |Bleu8 |

l

Couleur ||:| Bleud t“ ’ Modifier
l
l

Ajouter

Table: standard

T TILIITTIT 1™

Ee . SVE
T 1L
B B B O B
I
1T 1 1 1 e
EEEEEEE
1 1L 1L L i
m mm
ST 1L LT
e m .
EE =E =
I M

Editer...

Supprimer...

<
=

&

]
2
) () (70 g

| ok || Annuer || Aide ||Réiniialiser |

Cette fenétre propose un onglet « Couleurs » qui propose une palette simple dite
« standard ». La couleur sélectionnée peut étre modifiée en indiquant des valeurs RVB ou,

plus simplement, en cliguant sur « Editer » ce ﬂui ouvrira la fenétre suivante :

Annuler
Aide

Cyan 100 % ﬂ 3

Magenta 28% | Rouge 0 | Ieinte 196
Jaune m Vert 184 —| Saturation m
Khal m Eleu 255 —| Luminosité m

— i
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Il est possible de sélectionner a gauche une couleur, puis double cliquer pour afficher les
propriétés : déplacer le petit carré de la partie gauche pour faire varier ses caractéristiques
afin d’obtenir la couleur souhaitée. Il suffit en suite de valider pour ajouter la couleur dans
la palette aprés lui avoir donné un nom.

Il est également possible d’ouvrir d'autres palettes de couleur en cliquant sur s
i | ¢ corfig

Jregistry
[isoffice.cfg

3 cyk. soc
38 couleur. soc

3 gallery.soc
5 html.soc

) standard.soc
) sun-color . soc

3 web.soc

qui affiche les palettes disponibles. La palette par défaut est standard.soc.
9.4 - Insérer des dessins et des objets sur la carte

9.4.1 - Depuis la barre d’outils Dessin
Il faut utiliser les icones permettant de dessiner des formes prédéfinies.

9.4.2 - Depuis la Gallery

Si I'on veut modifier les objets (couleur de remplissage, des traits...) il faut comme pour
les cartes, les insérer par Cliquer-Glisser.
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9.4.3 -

Rappel sur les manipulations des objets

Supprimer un objet

Le sélectionner et utiliser la touche « Sup »

Couperl/copiericoller un

objet

Permet de refaire facilement a 'identique des objets (trés utile, par
exemple, pour des cercles représentant une ville). Attention, le plus
souvent les objets copiés sont collés directement sur I'objet d’origine !

Déplacer un objet :

Cliquer pour le sélectionner puis relacher et passer la souris sur I'objet
afin d’obtenir une croix : cliquer et déplacer

Redimensionner un

objet

Poignées de coin : L'objet est redimensionné sur deux axes a la fois.

Poignées sur les arétes : L'objet ne sera redimensionné que sur un
seul axe.

Proportion ? La touche \L pendant le redimensionnement garantit
de conserver le rapport largeur / hauteur de I'objet.

C’est ainsi qu’il faut procéder pour réduire/agrandir les cartes de
la Gallery

Tracer un objet

Pour tracer un objet, il faut sélectionner I'objet souhaité, placer le
curseur de la souris au point de la premiére coordonnée et glisser tout
en maintenant le bouton appuyé. L'objet est tracé avec les attributs
par défaut qui sont affichés dans la barre des objets.

@ A . .
La touche L utilisée en complément va amener des contraintes !

-avec ligne : des angles d'inclinaison (45/90°/180°)

-avec rectangle : un carré

-avec ellipse : un cercle

avec polygone : des droites sont tracées avec des angles de 45° en
45°

Changer les attributs

des objets

On appelle attribut toute propriété caractérisant I'apparence d'un
objet: couleur, type de pourtour, épaisseur des traits... lls sont
modifiables a tout instant : un clic sur I'objet avec le bouton droit
de la souris affiche un menu dit « contextuel ».

La modification peut également intervenir au travers de la barre
d'objet.

Sélectionner un objet

caché par un autre

-Faire passer I'objet supérieur en arriere-plan (utiliser les icénes avant
ou arriére-plan...)

ou [ e
-Utiliser la touche TAB [
apres les autres (sera peu utile si les objets sont tres nombreux !)

qui sélectionne les objets les uns

Ecrire dans tout objet

C’est possible ! Il suffit de faire un double clic, et aussitét, I'on peut
écrire un texte dans I'objet
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9.5 - Travaliller avec les objets

9.5.1 - Le menu contextuel
Un clic droit sur un objet fait apparaitre un menu « contextuel » souvent utile :

m Ligne,..

{} Remplissage. ..
Texte...

E}}» Position et taille. ..

Disposition k
Alignement r

Adapation du texte  »

Ancrage L
L] Légende...
b

Groupe L
oo Couper
% Copier

Les items proposent les fonctions jugées les plus utilises, ces fonctions se retrouvent soit
dans les menus, soit dans les barres d’outils dessin, image ou propriétés de I'objet ...

9.5.2 - Aligner des objets

Si I'on a dessiné plusieurs objets, il peut étre intéressant de les aligner de maniéere trés
fine. Aprés les avoir sélectionnés, le menu contextuel Alignement permet de choisir le type
d’alignement désiré.

Par défaut

Ligne...
Bemplissage...

Position et taille...

Caractére...

L8 F9e

Paragraphe...

Organiser
Alignement [D¢ A gauche
Refléter

Convertir

s Centré

* v v w

%D] A droite

| Grouper —E; En haut

i6hi  Dissocier ﬁ e

Combiner }_. En bas

Formes 3

Connecter

Saut

Couper

|

Copier

Coller
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Cette commande peut-étre répétée plusieurs fois pour centrer 2 objets I'un par rapport a
'autre par exemple pour centrer le rond rouge et le rond violet il a fallu les centrer
horizontalement puis verticalement.

9.5.3 - Grouper des objets

Si I'on a inséré ou dessiné plusieurs objets, il peut étre intéressant de les rendre
« dépendants » les uns des autres en les groupant. Une fois le groupe constitué lors du
déplacement, les emplacements respectifs des objets sont maintenus.

Aprés avoir sélectionné plusieurs objets, le menu contextuel permet de les regrouper en
choisissant Grouper.

] “‘tilﬂj,,‘} ] o ‘\"tlll:n*rf, o
Ay ol o -
& Oglp B % = =
| | | ]
- o - - - -
e v, -
o “dapntt g @ “foapntt @

Pour travailler dans un groupe (modifier un des objets) ou pour « dégrouper » des objets,
le menu contextuel propose deux items Groupe » Dissocier et Groupe » Editer le
groupe.

Il est possible de Grouper des groupes d’objets de la méme maniére que I'on groupe des
objets unitaires.

9.5.4 - Positionner des objets I'un par rapport a I’autre

La superposition d’objets, lorsqu’ils sont nombreux, peut apporter des difficultés de
conception... en effet LibO ne permet pas d’'identifier chaque couche objet !

Aussi est-il important de réfléchir, au début, a la conception du croquis. Il faut essayer de
positionner les objets dans le bon ordre dés le départ : il vaut mieux commencer par
dessiner les espaces les plus étendus et terminer par les plus petits, aussi, une sélection
ultérieure sera plus aisée.

Si malgré ces précautions un objet est devant un autre alors qu’il ne devrait pas, il est

possible, apres avoir sélectionné un des deux objets, de choisir par clic droit leur
positionnement réciproque.

] Alignérment » Wers 'avant

Adaptation du texte v Vers l'arrigre
Ancrage b ﬂ Tout d l'arriére
I_ g -
pioe LEQende... A I'arritre-plan
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9.6 - Interface graphique
°Les images peuvent étre redimensionnées et compressées avec le menu contextuel

Compresser ---> Images

r S|

= Informations sur l'image;

Type: Image Jpeg

Taille d'crigine : 3231 cmx 1873 cm (1221 x 708 px)
Afficher |3 taille : 1900 crn x11,02 cm 3163 DPI
Qualité de l'image: 58 kio

Mouvelle qualite : o

Calculer |

Dualité: a0

@ Compression JPEG

4k

(") Compression sans perte
Compression : g

[¥] Réduire Ia résolution de l'image

Largeur: 718 = px
Hauteur 416 =1 P
Résolution 96 | oer

Interpolation : n

[ QK J| Annuler |

_

- Gére l'affichage des informations courantes : dimensions initiales, dimensions dans
le document.

- Possibilité de réduire la résolution de limage en paramétrant une nouvelle
dimension (largeur/hauteur en pixels et PPI).

. Compression sans perte (PNG) ou avec perte (JPEG) avec possibilité de
paramétrer la qualité et le niveau de compression.

- Possibilité de sélectionner I'algorithme d'interpolation (resampling).

5 Nouveauté de la version 4.3
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9.7 - Les échecs lors de la manipulation des objets

9.7.1 -

lls sont toujours liés a notre méconnaissance de la construction de la carte en divers
objets, certains étant superposeés, les uns sans contour, les autres étant des polygones
non fermés. Penser aussi que des objets peuvent étre en « blanc » ou « transparent »...
mais bien présents ;

Généralités

Voir ci-dessous un exemple concret (Bretagne)

9.7.2 - Symptémes - Solutions
Impossible de : Reméde
Voir la barre outils| Si la barre outils contextuelle n'apparait pas, c’est
contextuelle gu’elle n'a pas été cochée dans le menu déroulant
« Afficher / barres d’outils ».
Sélectionner un  objet| Sélectionner 'ensemble et avec le Menu contextuel

MODULE DRAW - DOCUMENTATION UTILISATEUR

parmi d’autres

"Groupe : Dissocier "

ou utiliser « Groupe : Entrer »

En cas de difficulté, essayer de déplacer un des
objets pour vérifier que rien n'est caché

Modifier
objet

le contour d'un

Sélectionner le bon objet (attention aux
superpositions) et vérifier que I'objet a bien une ligne
de contour, si nécessaire en ajouter une.

Passer en mode Sélection
(les points de I'objet sont
édités)

Passer en mode Edition
(I'objet est sélectionné)

Changer de mode en cliquant sur le bouton « Editer
les points »

Glisser certains objets
cartes (de la Gallery ou
vers la Gallery)

Les cartes vectorielles complexes nécessitent de
longues opérations de calcul, si votre ordinateur est
peu puissant, il pourra planter avec certaines cartes
trop lourdes !

Remplir un polygone d’'une
couleur

S’il est impossible de remplir un polygone d'une
couleur, c’'est que le polygone n'est pas « fermé »
aussi cliquer sur l'outil « Points » pour les faire
apparaitre puis utiliser l'outil (qui a été ajouté)
« Fermer Bézier » ou passer en mode « Dessin ».
Voir cas concret ci-dessous

53/64




9.7.3 -

Une des difficultés que I'on rencontre souvent est liée a notre méconnaissance de la
maniere dont le fond de carte a été construit, ainsi il arrive que divers objets se
superposent comme le montre I'exemple suivant :

Exemple

Ce fond de carte semble
étre composé uniqguement
d'un seul et unique objet
« contour de la
Bretagne »...

Or il est constitué de la
superposition de 2 objets :
un fond (ici colorié en gris
et précédemment en
blanc !) et un contour ligne
(en noir, non fermé)

Aprés modifications,
remarquer que:

- I'objet « fond » n’a pas
de trait de contour

« invisible »

-I'objet « contour » a été
ici « fermé »avec trait de
contour en rouge et rempli
de hachures.
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10 - EFFETS

Tous les effets présentés ci-aprés sont applicables uniquement sur les objets vectoriels et
sont regroupés dans la barre d'outils Mode que I'on peut afficher en cliquant sur l'icbne
déployable « Effet » de la barre d’outils Dessin

ou

Menu Affichage » Barre d'outils » Mode.

@@ § v
oAl

L’outil « Rotation » G
Permet de faire pivoter I'objet sélectionné.

s
- t o I
I1' PO A 4

Les 4 poignées d’'angle permettent de faire pivoter I'objet sélectionné autour du point de
rotation. Le pointeur de la souris se transforme en arc de cercle.
Le point de rotation est déplacable.

=

< #

& \

= =
=

Les poignées du milieu permettent de décaler I'objet vers la direction souhaitée tout en lui
changeant son aspect.

L’outil « Retourner » E’-%

Permet de dessiner un objet symétriguement par rapport a un axe.

Quand on clique sur cette icdne, un axe de symétrie se place sur la figure. Cet axe peut
étre déplacé n’importe ou dans la diapo en cliquant sur une des poignées ou sur la ligne
elle-méme.

Prendre ensuite une des poignées de l'objet a reproduire symétriquement et la faire
passer par-dessus I'axe de symétrie.

Pour faire une symétrie verticale ou horizontale, Modifier » Refléter de la barre des
menus,

ou

Clic droit sur I'objet puis « Refléter » Verticalement ou Horizontalement.
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Objet de départ reflété verticalement reflété horizontalement

L’outil « En corps de révolution 3D » &
Permet, a partir d'un demi-objet dessiné en 2D, d’obtenir un objet en 3D

B

1.Dessiner un objet (2D) ou ici dans notre exemple Formes de base »trapéze de la
barre d’outils dessin.

2.Cliquer sur I'outil « En corps de révolution 3D » et positionner I'axe de symétrie.
3.Cliquer dans la sélection, I'objet en 3D se réalise.

4.Remplir avec une couleur ou un dégradé...

L N

—=—' Avant d’appliquer les instruments suivants a un objet, ce dernier devra étre d’abord
transformé en courbe. Ensuite il sera possible d’appliquer les transformations souhaitées.

L'outil « Positionner sur le cercle (en perspective) » "%
Déforme I'objet sélectionné en le drapant autour de cercles imaginaires et en ajoutant des
perspectives. Faites glisser une poignée de I'objet sélectionné pour le déformer.

EI-—-—TQTD
i =
1 1 & b -
- -
‘_',‘—-._ 1 a o
: : T-‘""-l.l E
Foaci o O uR
[} [} "'-‘ ¥ ¥
[ ] r S ¢
L r Il “al'y
i ; l‘f‘-..l_ ’ \J -,
' ; : B ¢/
==__1
= k= f ’r
i, ¥

L’outil « Positionner sur le cercle (incliner) » “
Déforme I'objet sélectionné en le drapant autour de cercles imaginaires. Faites glisser une

poignée de l'objet sélectionné pour le déformer.

[}
| ot )
1 1 ~‘t
S \
P
! 1 ‘I
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L'outil Déformer
Permet de faire glisser les poignées de 'objet sélectionné pour modifier sa forme.

=1

L’outil « Transparence » |
Permet de définir un dégradé de transparence.

Sélectionner I'objet de départ cliquer sur I'outil « Transparence »

Les deux points de réglage peuvent étre déplacés afin de régler la longueur du dégradé
(point noir) et son orientation (point blanc).

L’outil « Dégradé » L J|
N’est actif que si I'objet est rempli par un dégradé. Cela permet ensuite de paramétrer le
dégradé en jouant sur les points de placement des couleurs, sur la longueur et I'orientation
du remplissage en dégradé.

Point de placement
de la couleur 2, de la longueur
et de I'orientation

Point de placement
de la couleur 1
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11 - QUELQUES FONCTIONS SPECIFIQUES

Le module DRAW propose certaines fonctions permettant rapidement la création de
figures complexes.

11.1 - La duplication

Permet de définir manuellement quel objet déja créé devra étre dupliqué sur la méme
page en assurant a la fois un décalage et des transitions de couleur.

B

Apres avoir dessiné une forme initiale,
Edition » Dupliquer de la barre des menus. La boite de dialogue suivante s'affiche :

A partir d’'un simple losange, en configurant les paramétres de la duplication, on peut
obtenir le résultat suivant :

11.2 - Le fondu enchainé

Cette opération permet de simuler une transformation réguliere d’'une forme initiale a une
forme finale.

LA

—=—' |l faut d’abord dessiner la forme d’origine puis la forme finale.

B

Sur la page, dessiner la forme d’origine dans I'angle supérieur gauche, puis la forme
finale dans I'angle inférieur droit.

Edition » Tout sélectionner, puis Edition » Fondu enchainé de la barre des menus.
La boite de dialogue suivante s’affiche :

* Les pas correspondent a chaque étape de transformation. Entrer une valeur.

* Cocher la case « Attributs du fondu enchainé ». Le calcul de I'enchainement
prend en compte a la fois les couleurs et les tailles. Si la case est décochée,
seules les formes vont évoluer.

* Cliquer sur OK
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11.3 - Fontwork
Il s’agit d’appliquer a du texte des effets typographiques particuliers.

11.3.1 - Insertion d’un effet Fontwork

[a]|Gallerie Fontwork

Cliquer sur le bouton . de la barre d’outils Dessin.

La boite de dialogue « Fontwork Gallery » apparait a I'écran.
Cliquer sur le style Fontwork & appliquer au texte.

Cliquer sur « OK ».

Le texte coloré apparait dans le document comme un objet.
Double cliquer dans 'objet.

Le texte « Fontwork » s’affiche dans un cadre.

Double clic sur Fontwork puis saisir le texte sur lequel s’applique le style.
Valider en appuyant sur la touche EcHar.

Ajuster éventuellement la taille de I'objet.

11.3.2 - Modifier un objet Fontwork

B

Sélectionner I'objet Fontwork.
La barre d’outils « Fontwork » apparait a I'écran.
Utiliser cette barre pour réaliser les modifications.

Fontwork > X
Al Y -aal =AY~
1 2 3 4 5

1. Ouvre la boite de dialogue Fontwork Gallery |4. Modifie I'alignement du contenu

2. Accés aux formes Fontwork 5. Modifie I'espacement entre les
caractéeres

3. Affecte la méme hauteur aux caracteres
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12 - CREER UN ORGANIGRAMME

12.1 - Créer la structure de base d’un organigramme

Fichier » Nouveau » Dessin de la barre des menus.

2.Choisir une forme et la dessiner dans la diapo.

Iy -
3.Cliquer sur l'icone déployable « ConnecTEUR" €
liaisons demeurent en cas de déplacement des objets.

points de connexion.

connexion d’'une autre forme et relacher.

1.Cliquer sur I'icone déployable « Orcanicramves " de la barre d’outils Dessin.

Point de collage

_ Point de réglage
des objets ) du connecteur

Points de collage 57

Eif
(|
i
>
=

Base d’'un organigramme
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COLLAGE" & de la barre d’outils Dessin. La boite suivante s’affiche :

de la barre d'outils Dessin et
choisir un type de connecteur. Un connecteur est une ligne reliant des objets. Ces

4.Déplacez le pointeur sur le bord d'une forme de maniére a faire apparaitre les

5.Cliquez sur un point de connexion, faites glisser le curseur vers un point de

Il est possible d’'ajouter des points de collage en cliquant sur le bouton « Points pe
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12.2 - Ajouter un remplissage de couleur a une forme

B

Cliquer sur le bouton « RempLISSAGE" B de la barre d'outils Ligne et remplissage
pour avoir acces aux styles de remplissage. Se reporter au 8 Modifier le style de

remplissage.

12.3 - Ajouter du texte aux formes de I'organigramme

B

Double-cliquer sur la forme, puis saisir ou coller votre texte.
ou

Cliquer sur le bouton « TexTe" 1 de la barre d’outils Dessin. Saisir ou copier votre
texte dans I'objet texte.
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13- MONTER UN OBJET BITMAP DANS UNE DES FORMES
DE BASE

B

Fichier » Nouveau » Dessin de la barre des menus.

Insérer votre image par le menu Insertion » Image » a partir d’'un fichier...
Par clic droit » Position et taille, repérer les dimensions de votre image.

Choisir le bouton « RectancLe” ™ de la barre d’outils Dessin, dessiner un rectangle
ayant des dimensions supérieures a l'image.

=
Liberté » Egalité » Fraternité

REPUBLIQUE FRANCAISE

Choisir le bouton « ELupse” = de la barre d’outils Dessin, dessiner un cercle dont
les dimensions ne dépassent pas le rectangle bleu, le placer au milieu de ce dernier
puis sélectionner les deux formes.

Modifier » Combiner de la barre des menus. Les deux formes fusionnent pour

donner ceci :
= 1 |
7
;"-" mi i
Liberté = Egalité = Fraternité
REPUBLIQUE FRANGAISE
o 5 |

Placer maintenant la nouvelle forme sur I'image et sélectionner les deux objets.
= 1 ]

Modifier » Formes Modifier » Soustraire de la barre des menus.
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L'image prend alors la forme de I'objet cercle

—
*« Egalité » Frate

~1E Fe
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